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1.1 Windows, Menus, and Tools 
SAS Enterprise Guide has many windows, menus, and tools. You can customize the appearance 
of SAS Enterprise Guide—closing some windows, opening others, and rearranging them all—
until it looks just the way you want. Then, SAS Enterprise Guide will save those changes so the 
next time you open it, everything will be just where you left it.  

Here is SAS Enterprise Guide with its windows in their default positions.  

 

SAS Enterprise Guide has eight basic windows (some of which are open by default and others 
closed), plus a workspace, menus, and tools. You can open any of these windows by selecting 
them from the View menu, or by clicking the icon for that window in the toolbar. 

Process Flow window  This window displays the items in a project and their 
relationship using a Process Flow Diagram. This window is open by default. 

Project window  An alternative to the Process Flow window, the Project window 
displays the items in a project in a hierarchical tree diagram. This window is open by  

 default, but is hidden behind the Process Flow window. To bring the Project window 
 forward, click the Project tab below the Process Flow window. 

Task List window  The Task List window is open by default and lists all available 
tasks. You can view the tasks sorted by category or in alphabetical order by  clicking the 

 tabs at the top of the window. You can open a task by clicking its name.

Toolbar 

Process Flow window
Task List 
window 

Task Status window

Workspace 

Menu bar 

Project window
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Task Status window  The last window that is open by default is the Task Status 
window. This window displays notes about any tasks that are running either locally or 

 on a remote server. 

Server List window  The Server List window lists available SAS servers and the files 
and SAS data libraries on those servers. This window is closed by default. 

Binder List window  The Binder List window lists available binders and their 
contents, and is closed by default. 

Stored Process List window  The Stored Process List window lists any stored 
processes you have created, and is closed by default. 

What is window  The What is window displays information describing menus and 
tools, and is closed by default. See section 1.11 for more information about using the 

 What is window. 

Workspace  The workspace is not itself a window, but it is very important. This is where the 
document windows appear. The document windows display your data, results, code, logs, and 
notes. The workspace is always there and cannot be closed. However, you can open and close 
individual documents inside the workspace. The document windows are discussed in more 
detail in the next two sections.  

Pinning windows  You can minimize a window by clicking the pushpin icon  in the 
upper-right corner. SAS Enterprise Guide will reduce that window to a tab along the edge of the 
SAS Enterprise Guide application. Then, when you move the cursor over the tab, the window 
will expand. When you move the cursor out of the window, it will be reduced to a tab again. To 

unpin a window, click the sideways pushpin icon . 

Restoring windows  Once you have rearranged your windows, you may decide you want 
them back where they started. To restore them to their original locations, just select 
Tools Options from the menu bar. Then, in the General page of the Options window, click 
Reset Docking Windows. 
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1.2 Projects 
In SAS Enterprise Guide, all the work you do is organized into projects. A project is a collection 
of related data, tasks, results, code, logs, and notes. Projects help you by keeping track of 
everything, even if your data are scattered in many directories or on more than one computer. 
That way, when you come back to an old project six months or a year later, you won’t be left 
wondering which data sets you used or what reports you ran.  

You can have as many projects as you like, and you can use a data set over and over again in 
different projects, so there is a lot of flexibility. However, you can only have one project open at a 
time. Also, if you share a project file with someone else, that person must have access to your 
data files and any other items you reference. 

To create a new project, select File New Project from the menu bar. To open an existing 
project, select File Open From My Computer or File Open From SAS Server/Binder and 
navigate to your project. 

Process Flow and Project windows  The Process Flow window displays projects using a 
Process Flow Diagram, while the Project window displays projects in a hierarchical tree diagram. 
In either window, the items in your project are represented by icons, and connected to show the 
relationship between items. This book focuses more on the Process Flow window, but most of 
the features shown will work in the Project window too. Here are a Process Flow window and a 
Project window showing the same project. This project contains several types of items: data, 
tasks, results, code, logs, and a note.  

 

Data  Data files in a project may be SAS data tables, raw data files, or files from other databases 
or applications, such as Microsoft Excel spreadsheets. Projects contain pointers to data files, not 
the actual data. If you delete a project, your data files will still exist. 

Tasks Tasks are specific analyses or reports that you run, such as Import Data, Analysis of 
Variance, or Bar Chart. Every time you run a task, SAS Enterprise Guide adds an icon 
representing that task. 

Results  Results are reports or graphs produced by tasks you run. Results are represented by 
icons labeled with the type of output (HTML, PDF, RTF, or text) and the name of the task. 

Notes  Notes are optional text files that you can use to document your work or record 
comments or instructions for later use. To create a note, select File New Note from the menu 
bar. A text window will open, allowing you to type whatever you wish. 
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Showing properties and opening items  You can display the properties for any item by 
right-clicking its icon in the Process Flow or Project window and selecting Properties from the 
pop-up menu. You can open any item by double-clicking its icon, or by right-clicking its icon and 
selecting Open from the pop-up menu.  

 

Code and log files Code files are SAS programs, either ones that SAS Enterprise Guide 
writes when you run a task, or ones that you have written. Log files are text files written by SAS 
that contain details about how a particular task ran. When you run a task, code and log icons are 
automatically added to the Project window, but not to the Process Flow window. You can open 
the code and log in a Process Flow window by right-clicking the task icon and selecting Open 
Code or Open Log. If you want the code and log to appear automatically in the Process Flow 
window, select Tools Options from the menu bar, and in the Project Views page under the 
words Process Flow, check Show generated code items and Show SAS output log. 

Renaming and deleting items  You can rename most items by right-clicking the item and 
selecting Rename from the pop-up menu. You can delete an item in a project by right-clicking 
and selecting Delete. Note that if you delete data from a project, only the pointer to that data is 
deleted, not the actual data file.  

Saving a project  To save a project, select File Save Project or File Save project-name 
from the menu bar. Each project is saved as a single file and has a file extension of .egp.  
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1.3 Maximizing and Splitting the Workspace 
The workspace is where all the document windows appear: data, results, code, logs, and notes. 
That’s a lot to fit in one little area, and it probably won’t be long before you’ll feel the need to 
enlarge the workspace. You can always resize windows by clicking and dragging the borders, 
but two handy tricks will make managing your workspace quicker and easier.  

Maximizing 
the workspace  
To make the 
workspace as large 
as possible, select 
View Maximize 
Workspace from 
the menu bar  
or click the 
Maximize 
Workspace button 
on the toolbar 

.  

 

 

 

 

When you maximize 
the workspace, the 
Process Flow, Task 
List, and Task Status 
windows become tabs 
pinned to the edges of 
the SAS Enterprise 
Guide application. A 
window will expand 
if you move the 
cursor over the tab. 
When you move the 
cursor away, the 
window will be 
reduced to a tab 
again. 
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Splitting the workspace  You can display document windows side by side or one above 
the other. First, open all the documents you wish to view. Then, in the workspace, right-click the 
tab for one document window and select either New Horizontal Tab Group or New Vertical 
Tab Group. This splits the workspace in two. Repeat this until all the documents you wish to see 
are visible. 

 

This window 
shows three 
documents in a 
vertical tab group: 
the Volcanoes 
data set, the 
results of a List 
Data task, and the 
code generated by 
that task. 

 

 

 

 

 

 

 
To move documents from one section of the workspace 
to another, right-click a document tab and select Move 
Previous or Move Next from the pop-up menu. The 
document you move will appear on top of other 
documents in that section. 

 

Restoring the workspace  To return the workspace to its normal size, either select View  
Maximize Workspace from the menu bar or click the Maximize Workspace button on the 
toolbar. You can restore the windows to their default locations by selecting Tools Options 
from the menu bar, and then clicking Reset Docking Windows in the General page of the 
Options window.  
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1.4 Running and Rerunning Tasks 
Running tasks is, of course, what SAS Enterprise Guide is all about. Regardless of which task 
you choose to run, the basic steps are the same: select the data, open the task and select settings, 
and then run the task.  

Setting the 
active data table  
SAS Enterprise 
Guide will run a task 
using the data table 
that is currently 
active. The name of 
the active data table 
appears in the 
Active Data box on 
the toolbar. To 
change to one of the 
other data tables in 
your project, click 
the arrow in the 
Active Data box and 
select another data 
table from the pull-
down list, or just 
click the data table 
icon in the Process Flow window. Here, the window shows the Tours data table being selected. 

Opening a task  To 
open a task, select it 
using menus or click its 
name in the Task List 
window. The window 
for that task will open. 
Here, the window 
shows the List Data task 
being opened. 
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Running a task  
In the task window, 
you assign variables 
to task roles and 
then select options. 
When you are 
satisfied with all the 
settings, click Run.  

If you decide you 
want to stop a task 
while it’s running, 

click the square  
on the right side of 
the toolbar, or select 
Code Stop from 
the menu bar. 

 

Rerunning a 
task  To make 
changes to a task 
and run it again, 
first, reopen the 
task by right-
clicking the task 
icon in the Process 
Flow window and 
selecting Open 
from the pop-up 
menu. You can 
also reopen a task 
by double-clicking 
the task icon. Once 
the task window is 
open, you can 
make changes. 
Then, click Run to 
rerun the task. If 
the data have been 
updated and you want to rerun a task without making any changes to the task settings, you can 
right-click the task icon and select Run This Task or Run Process Flow From Here from the pop-
up menu. 
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1.5 SAS Data Tables 
SAS Enterprise Guide can read and write many kinds of data files (see Chapter 2 for more on this 
topic), but for most purposes, you will want to have your data in a special form called a SAS data 
table. When you open a SAS data table, it is displayed in the workspace in a Data Grid window. 
The following Data Grid shows the Tours data table with a new tour added for Lassen.  

 

 

 

Terminology  In SAS Enterprise Guide, data tables are also called data sets, rows are also 
called observations, and columns are also called variables. SAS Enterprise Guide uses all these 
terms. Some tasks refer to columns and others to variables, depending on the context. In the 
Tours data table, each row represents a different tour, while each column shows a different type 
of information about the tour: volcano name, city of departure, days, price, and difficulty.  

Data types and data groups   In SAS Enterprise Guide, there are two basic types of data: 
numeric and character. Numeric data are divided into four data groups: numeric, currency, time, and 
date. For each of these, SAS Enterprise Guide has special tools: informats for reading that type of data, 
functions for manipulating that type of data, and formats for displaying that type of data. SAS 
Enterprise Guide uses a different icon to identify each kind of data in Data Grids and tasks. 

  Character data may contain numerals, letters, or special characters (such as $ or !) and 
can be up to 32,767 characters long. Character data are represented by a red pyramid. 

  Currency data are numeric values for money and are represented by a picture of the 
dollar, yen, and euro symbols. 

  Date data are numeric values equal to the number of days since January 1, 1960. The 
table below lists four dates and the corresponding SAS date and formatted value: 

Date  SAS date value MMDDYY10. formatted value 
January 1, 1959  -365 01/01/1959 
January 1, 1960  0 01/01/1960 
January 1, 1961  366 01/01/1961 
January 1, 2006 16802 01/01/2006 

Columns 
(also called Variables)

Rows  
(also called Observations) 

Data Table  
(also called a Data Set) 
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You will rarely see unformatted SAS date values in SAS Enterprise Guide. (See Chapter 
3 for more information about formats.) However, because dates are numeric, you can 
use them in arithmetic expressions to find, for example, the number of days between 
two dates. Datetime values are included in this data group, and are the number of 
seconds since January 1, 1960. Date data are represented by a picture of a calendar. 

Time data are numeric values equal to the number of seconds since midnight. Time data 
are represented by a picture of a clock.     

Other numeric data that are not dates, times, or currency are simply called numeric. 
They may contain numerals, decimal places (.), plus signs (+), minus signs (-), and E for 
scientific notation. Numeric data are represented by a blue ball.  

Numeric versus character  If the values of a column contain letters or special characters, 
they must be character data. However, if the values contain only numerals, then they may be 
numeric or character. You should base your decision on how you will use the data. Sometimes data 
that consist solely of numerals make more sense as character data than as numeric. Zip codes, for 
example, are made up of numerals, but it just doesn’t make sense to add, subtract, multiply, or 
divide zip codes. Such numbers work better as character data. 

Column names  Column names in SAS Enterprise Guide may be up to 32 characters in length, 
and can begin with or contain any character, including blanks. 

Using SAS Enterprise Guide data in SAS  Any data created in SAS Enterprise Guide can 
be used in SAS, but the default rules for naming variables are different in SAS because SAS uses the 
VALIDVARNAME=V7 system option, while SAS Enterprise Guide uses VALIDVARNAME=ANY. 
For easier compatibility, you may want to follow these rules when naming columns: choose 
column names that are 32 characters or fewer in length, start with a letter or underscore, and use 
only letters, numerals, and underscores.  

Missing data  Despite your best efforts, your data may be incomplete. The value in a particular 
column may be missing for some rows. In those cases, missing character data are represented by 
blanks, and missing numeric data are represented by a single period (.). In the preceding Data 
Grid, the value of Price is missing for the tour of Lassen, and its place is marked by a period. The 
value of Difficulty is missing for the same tour and is left blank.  

Documentation stored in SAS data tables  In addition to your actual data, SAS data 
tables contain information about the data table, such as its name, the date that you created it, and 
the version of SAS you used to create it. SAS stores information about each column in the data 
table, including its name, type, and length. This information is sometimes called the descriptor 
portion of the data table, and it makes SAS data tables self-documenting. This information is what 
you see in the Properties windows for data tables and columns, which are described in more detail 
in the next two sections. 
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1.6 Properties of Data Tables 
Perhaps you have been given a SAS Enterprise Guide project that was created by someone else 
and it’s up to you to figure out what it does. After reading any notes, the next thing you would 
probably want to do is check the properties of the data tables.  

Opening the Properties window  From the Process Flow window, you can display 
information about a data table by right-clicking its icon and selecting Properties from the pop-up 
menu. In the following window, Properties is being selected for the Volcanoes data table. 
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General page  
The General page of 
the Properties 
window for a data 
table displays basic 
information about 
the table: its name, 
when it was created 
and last modified, 
the number of rows 
and columns, and 
whether it is indexed 
or compressed.  

 

 

 

 

 

 

Columns page  If 
you click Columns in 
the selection pane on 
the left, the Columns 
page will open. Here, 
SAS Enterprise Guide 
displays information 
about each column: 
its name, type, length, 
format, informat, and 
label. You cannot 
change the properties 
of columns in the 
Properties window 
for a data table. To 
make changes, use the 
Properties window 
for an individual 
column as described 
in the next section. 
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1.7 Properties of Columns 
When you open a Properties window from inside a Data Grid, it displays properties for an 
individual column, and you can make changes to those properties. 

Setting the update mode  
If the words read-only appear 
after the name of the data table 
at the top of the Data Grid, then 
the table is in read-only mode 
and you will not be able to 
make changes. To switch to 
update mode, select 
Data Read-only from the 
menu bar. This toggles the data 
table from read-only to update 
mode.  

 

 

 
 
Opening the Properties window  To open the Properties window, right-click the header 
of a column and select Properties from the pop-up menu. In the preceding Data Grid, Properties 
is being selected for the  
column Height. 

General page  The 
Properties window has  
several pages. If General is  
the only page available in the 
selection pane on the left, then 
the data table is in read-only 
mode and you need to switch  
to update mode. 

The General page displays basic 
information for the column: its 
name, label, type, group, and 
length. You can change any of 
these properties except length. 
In the example window, the 
column name has been changed 
to HeightMeters, and the label 
to Height in Meters. This 
column is numeric and has a 
length of 8. 
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Informats page  Click Informats 
in the selection pane on the left to 
open the Informats page. Informats 
(also called input formats or read-in 
formats) tell SAS Enterprise Guide 
how to interpret input data. If you 
edit the data table, SAS Enterprise 
Guide will use informats to 
interpret any values you type. There 
are different informats for character, 
numeric, date, time, and currency 
data. The example column uses the 
default numeric informat, w.d, with 
a width of 12 and no decimal places. 
See section 2.14 for a table of 
commonly used informats. 

  

 

Formats page  Click Formats in the 
selection pane on the left to open the 
Formats page. Formats (also called 
display formats) tell SAS Enterprise 
Guide how data should look in Data 
Grids or reports. There are different 
formats for character, numeric, date, 
time, and currency data. The format 
COMMAw.d with a width of 6 and no 
decimal places has been selected in 
the example for the column 
HeightMeters. See section 3.3 for a 
table of commonly used formats. 

 

 

 

  
Results  Here is the 
Data Grid showing the 
new name, 
HeightMeters, and 
format with commas.  
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1.8 Scheduling Projects to Run at Specific Times  
Sometimes you may want to create a project, but then run it at a different time.  For example, if 
you have data that are updated on a regular basis, you might want to automatically rerun the 
project using the new data.  Or, if your data files are very large, you might want to run your 
projects at night so that SAS Enterprise Guide is not using valuable resources during work 
hours. 

Scheduling a project  To schedule a 
project, select Tools Schedule Project 
from the menu bar. This opens the 
Scheduled window with the Task page 
displayed. When you schedule a project, 
SAS Enterprise Guide creates a script that is 
saved in a file on your computer.  The name 
and path of this script is displayed in the 
Run box. The Start in box displays the 
folder in which the script will run.  Your 
computer and user name are displayed in 
the Run as box.  Click the Set password 
button to open the Set Password window. 
Enter the password for your user name (the 
same password you use when you log on to 
your computer), and click OK. 

 

  

 

Setting the run frequency  To  
tell SAS Enterprise Guide when to run  
the project, click the Schedule tab of  
the Scheduled window.  Click New.  
Then, select the frequency to run the  
project from the drop-down list under 
Schedule Task.  You can schedule your 
project to run just once at a specified  
time as shown here, or you can schedule 
your project to run on a regular basis.   
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Setting the date and time  To set 
the time the project will start running, 
click the up and down arrows on the 
Start time box, or simply select the time 
and type a new value. To choose a date 
other than today, click the arrow in the 
Run on box and select a date from the 
pop-up calendar. 

Other settings  If you click the 
Settings tab, you will see other options, 
including the maximum length of time 
a project will be allowed to run and 
whether it will run if your computer 
has gone into sleep mode.  

When you are satisfied with all the 
settings, click OK to schedule the 
project. 

 

 

Running the project  The project will not run if it is open or if the computer is turned off at 
the time the project is scheduled to run. However, if you have a different project open, the 
scheduled project will still run.  

Viewing the 
results  To see the 
results of your 
scheduled run, open 
the project after it has 
completed running. If 
you are not sure 
whether a project ran, 
you can confirm this 
by opening the 
Properties window for 
that project. To open 
the Properties window 
for a project, click the 
background of the 
Process Flow window 
and select Properties 
from the pop-up 
menu, or select File  
Properties from the 
menu bar. The Last modified field shows the date and time that the project last ran. 
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1.9 Viewing and Editing SAS Code Generated by a Task 
If you are a SAS programmer, you’ll probably want to see the SAS code generated by SAS 
Enterprise Guide. You may want to edit the SAS code generated by SAS Enterprise Guide. There 
are several ways to do this. This section shows some of them. 

Viewing code 
generated by a 
task  Many task 
windows have, in 
the left corner, a 
Preview code box. If 
you check this box, 
SAS Enterprise 
Guide will open a 
Code Preview 
window displaying 
the code that SAS 
Enterprise Guide has 
written for that task.   

 

 

 

Inserting code in 
a task  Here is a 
Code Preview 
window for a List 
Data task. You can 
see that it uses PROC 
PRINT.  If you want 
to add code to the 
task, you can click 
Insert Code. This 
opens a User Code 
window. 
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You cannot edit the existing code generated by a task, but the User Code window allows you to 
add code at specific points in the program. When you run the task, SAS Enterprise Guide will 
run the code you inserted, in addition to the code generated by the task.  

 

Editing code generated by a task  If you want to be able to edit all parts of the code 
generated by a task, or code from tasks that do not have a Preview code option, you can make a 
copy of the generated code, and then edit it.  To do this, run the task, and then right-click the task 
icon in the Process Flow window, and select Add As Code Template. SAS Enterprise Guide will 
open a code window in the workspace containing the code generated by the task.  

You can edit this code in any way you wish. Because this code is a copy of the code generated by 
the task, any changes you make here will not affect the task, nor will any changes you make to 
the task be reflected in this code. When you have made all the changes you wish to the code and 
are ready to run it, select Code Run on Local from the menu bar. If you want to run the code 
on another server, select Code Select Server.  

Code created in this way is 
embedded in your project 
and not saved as a separate 
file.  For more information 
on embedding code, see the 
next section. 
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1.10 Writing and Running Custom SAS Code  
You can accomplish a lot using tasks in SAS Enterprise Guide, but sometimes you may need to 
do something for which there is no predefined task.  At those times, you may want to write your 
own SAS programs or import programs written outside SAS Enterprise Guide. 

Writing a new SAS 
program  You can open a 
Code window and type a 
new SAS program. To open 
a new Code window, select 
File New Code from the 
menu bar.  An empty Code 
window will open in the 
workspace.  The code editor 
in SAS Enterprise Guide is 
SAS syntax-sensitive, which 
means that SAS keywords 
are displayed in blue, 
comments are green, 
quoted strings are pink, 
and so forth. 

Opening an existing SAS program  If you have existing SAS programs that you want to 
include in your project, you can open them by selecting File Open From My Computer from 
the menu bar. Navigate to the existing SAS program and click Open. This opens a Code window 
in the workspace, where you can edit the program.   

Saving versus embedding  
Any new programs you write are 
automatically embedded in your 
project.  This means that the 
program’s code does not exist in a file 
outside the project. To save the SAS 
code outside the project, either right-
click the icon for the code in the 
Process Flow window and select Save 
Code As from the pop-up menu, or 
save the code from the Properties 
window. To view the properties of the 
code, right-click the icon for the code 
in the Process Flow window and select 
Properties from the pop-up menu.  
Then, in the General page, click Save 
As. If you save the code to a file, then 
the program is not embedded, and 
any changes you make to the code in 
SAS Enterprise Guide will be  
saved in the file rather than as part of the project.  
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When you open an existing SAS 
program from a saved file, it is not 
automatically embedded in your 
project.  If you want to embed the 
program in your project, then open 
the Properties window for the code 
and click the Embed button. After 
you embed the code, any changes 
you make to the code in SAS 
Enterprise Guide will be saved as 
part of your project rather than in 
the file.  

Running your code and 
viewing the SAS log  When 
you are ready to run your code, 
select Code Run on Local to run 
on your local server or Code Select 
Server to choose a different server. 
When you run code in SAS 
Enterprise Guide, if there is an error, the default action is to open a SAS log window in the 
workspace.  If there is no error, then the SAS log will not automatically open.  To view the SAS 
log after running code, right-click the icon for the code in the Process Flow window and select 
Open Log.  By default, the Process Flow window does not show icons for the log, but the Project 
window does. You can change these default settings in the Project Views page of the Options 
window.  Open the Options window by selecting Tools Options from the menu bar.  The 
following shows a portion of the SAS log generated from running a SAS program. 
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1.11 Using SAS Enterprise Guide Help 
In SAS Enterprise Guide, help is never far away. You can find help via the Help menu, and you 
can also find help inside many windows and via the toolbar. 

What is window  To open the What is window, click the What is icon on the toolbar. Then, point 
the cursor at a menu item or tool, and the What is window will describe that menu item or tool.  

 

Context-sensitive help  The List Data window provides a good example of the context- 
sensitive help provided inside task windows.  

 

Animated Help 

 Help Box 

Help Button 

What is Icon 

 

What is Window 
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There are three main types of context-sensitive help: 

 Animated help demonstrates how to assign variables to task roles.  

 The Help box near the bottom of the window displays textual help. As you move your 
cursor around the window, the text automatically changes to describe what the cursor 
is pointing to. 

 The Help button in the right corner gives you more extensive help. When you click it, 
the SAS Enterprise Guide Help window opens.  

SAS Enterprise Guide Help  If you click the Help button in a task window, SAS 
Enterprise Guide will open the Help window and display information about the current task. 
You can also open the Help window by selecting Help SAS Enterprise Guide Help from the 
menu bar, but then it’s up to you to find the right section of help for your needs. 

 

The Help window has two main panes: the Navigation pane on the left, and the Topic pane on 
the right. In the Navigation pane, you can choose from four tabs. 

 The Contents tab shows an expandable table of contents for the SAS Enterprise Guide 
documentation.  

 The Index tab allows you to browse the index for both SAS Enterprise Guide and SAS 
syntax help. If you type a keyword or part of a keyword, you will jump to that part of 
the index.  

 The Search tab finds every occurrence of the words you type in both the SAS Enterprise 
Guide and SAS syntax help.  

 The Favorites tab allows you to make a list of your favorite help topics so that you can 
find them more easily in the future. 
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1.12 Using the Options Window 
The Options window allows you to change many SAS Enterprise Guide default behaviors. To 
open the Options window, select Tools Options from the menu bar. 

Data General options  To open the Data > Data General page, click Data General in the 
selection pane on the left.  

 

If you have large data tables, columns might be easier to find if they are arranged in alphabetical 
order. To list columns alphabetically in task windows, check the box in front of Display columns 
in alphabetical order.  

By default, the Data Grid uses column names, not labels, for column headers. To change this, 
check the box in front of Use labels for column names. 

If you have large data tables on remote servers, you may be able to improve performance by 
unchecking Automatically open data when added to project.  

Tasks General options  To open the Tasks > Tasks General page, click Tasks General in the 
selection pane on the left.  

At the top of this page, you see the default footnote for SAS Enterprise Guide output. You can 
type a new default footnote or set it to blank.  
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Near the bottom of the page is another useful option. Some tasks in SAS Enterprise Guide 
include in the results the name of the SAS procedure used by that task. In these results, you will 
see titles like “The FREQ Procedure,” “The MEANS Procedure,” or “The ANOVA Procedure.” 
You can eliminate these titles by unchecking the box in front of Include SAS procedure titles in 
results. 

 

Restoring the default windows  To restore windows to their default layout, click General 
in the selection pane on the left. Then, click Reset Docking Windows.  

Changing the default output type or style  To change the default output type, click 
Results General in the selection pane on the left, and check the type of output you want. To 
change the default output style, click HTML, RTF, or PDF in the selection pane on the left. Then, 
select the output style you want. See Tutorial C or section 10.2 for more details about changing 
output styles. Section 4.14 discusses changing the output type for queries, and section 9.6 
discusses changing the output type for graphs. 

Saving and resetting options  Click OK to close the Options window and save the 
changes you have made. Once you set options, they stay in effect for future SAS Enterprise 
Guide sessions. If at a later time, you decide you want to restore everything in the Options 
window to the default settings, simply click Reset All in the left corner. 
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